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1. Introduction      

As surgical skills develop in spinal field, transpedicular screw fixation of the lower thoracic, 
thoracolumbar, and lumbar spines have already been performed successfully, even using 
freehand technique by trained surgeons. The benefits of transpedicular screw fixation are 
widely accepted in the thoracolumbar spinal region for very stable fixation effect. Abumi et 
al first introduced transpedicular screw fixation in the subaxial cervical spinal region in 1991 
and reported their initial clinical results in 1994 [1]. Since then, some other spinal surgeons 
began to accept transpedicular screw fixation in the subaxial cervical region as one choice 
[5]. But whether this fixation method can be accepted widely as a routine choice has been 
disputed till now. The main concern comes from the potential violation of the pedicle 
cortices and following damages to adjacent neurovascular structures [6][12]. To diminish 
subaxial cervical pedicle (SCP) screw malposition ratio as low as possible and to ensure 
successful clinical results, the complex morphologic features and projections of subaxial 
cervical pedicles should be clearly understood. That is, the exact diameter, inclinations at 
transverse and sagittal plane, cortical thicknesses at different orientations, and cortical 
thicknesses adjacent to pedicle entrance should be determined before any transpedicular 
screw fixation was performed, even by experienced surgeons using meticulous surgical 
techniques[Fig.1]. Although morphologic studies of the cervical spine have been reported as 
a way to evaluate the feasibility and safety of the technique, many have focused on 
transverse diameter of the pedicles, which is far from enough [3].Thorough understanding 
of the subaxial cervical spinal pedicle anatomy is mandatory to avoid injury to the vertebral 
artery, spinal cord or a nerve root [8][11][14]. 
Because of their inherent ability to render bony anatomy in three dimensions, CT scans can 
provide the best osseous detail of subaxial cervical pedicles. Volumetric CT could 
reconstruct multiplanar CT images based on raw sequential transaxial CT images [7]. 
Multiple planar reconstruction (MPR) CT images could provide vivid anatomic data of 
subaxial cervical pedicles at different planes and different orientations for further detailed 
study. MPR CT images can be reconstructed using the CT-machine attached Advantage 
Workstation. If time permitted, quantitative measurement of MPR CT images can be 
fulfilled using the measurement tools of the CT machine-attached Advantage Workstation. 
But in clinical practice, large clinical CT scanning tasks are under schedule，the Advantage 
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Workstation could only fulfil routine MPR reconstruction and measurement work; it is not 
realistic to reconstruct wanted subaxial cervical MPR CT images and to finish quantitative 
measurement using the measurement tools of the Workstation at every timeうFig. 2え. Also, 

one could not expect that a CT-machine operator could reconstruct satisfied MPR CT images 
and finish relative measurement as a spinal surgeon really needed. If primary MPR CT 
images are not qualified, reviewing or reconstructing more MPR images based on raw CT 
data for further observation and quantitative measurement becomes more difficult. One 
feasible substitute choice is to develop other software which is free of CT-machine and could 
fulfil reconstructing satisfied MPR CT images and quantitative measurement based on raw 
transaxial CT images at a free computer. 
 

 

Fig. 1. Lateral wall violation of mispositioned screw trajectory 

 

 

Fig. 2. It is not realistic to finish quantitative measurement using the measurement tools of 
the CT machine-attached Advantage workstation at every time 

To some extent, we found ImageViewer software could fulfil this requirement. The software 
is one sharestation of Silver picture archiving and communication system (PACS) which was 
developed by Beijing Silver medical information Technical Corporation Limited of People’s 
Republic of China (webdress: http://www. minipacs. com). The software could provide 
qualified electronic MPR CT images with reference ruler present based on sequential raw 
transaxial CT images (Fig.3).  However this software also has some defects; for example, it 
could not finish electronic measurements on reconstructed MPR CT images. Later we found 
this defect could be compensated by AutoCAD software with the help of Adobe Photoshop 
software.  
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Fig. 3. Raw CT image opened in ImageViewer interface (Chinese Version) 

In this chapter we describe the technique of using AutoCAD2010 software to perform 
quantitative electronic measurement on subaxial cervical MPR CT images which were 
reconstructed with Imageviewer interface of Silver PACS software at the basis of sequential 
raw tranaxial CT images. As the morphology of SCP and quantitative anatomical data were 
got, unsuitable pedicles were rejected; successful subaxial cervical transpedicular screw 
fixation could be finished.  

2. Important 

To ensure accuracy of subaxial cervical transpedicular fixation, the pedicle’s morphology and 
orientation must be clearly understood preoperatively. Multiple planar reconstructed (MPR) 
CT images can provide vivid MPR images for detailed observation (Fig.4). Meanwhile, 
quantitative electronic measurement of these images can be fulfilled using the measurement 
tools of the CT machine-attached Advantage Workstation. Theoretically, all needed 
quantitative data could be easily obtained at Advantage Workstation. But as large routine 
clinical CT scanning tasks and multiple planar reconstruction works are under schedule every 
day, it is not realistic to do extra MPR reconstructions and quantitative electronic measurement 
of subaxial cervical pedicles at Advantage Workstation every time as one spinal surgeon really 
needs. If there exists some other software which can fulfil the multiple reconstruction work 
meanwhile fulfil quantitative measurement which is free of CT machine, that would be a good 
substitute solution method. ImageViewer software is one sharestation of Silver picture 
archiving and communication system (PACS), it was developed by Beijing Silver medical 
information Technical Corporation Limited and has been authorized to our hospital. Primarily 
the software was developed to provide online command dashboard screen observation of raw 
CT images at remote terminal computers; meanwhile it also could reconstruct qualified 
electronic MPR CT images with reference ruler present by reformatted method based on 
sequential raw transaxial CT images (Fig.2).  Also the software could finish some primary 
linear and angular measurement on raw digital images, although not accurate. To our great 
pity, it could not finish electronic measurements on reconstructed MPR CT images.  
To compensate this defect, we used the computer’s PrtSc key to capture a snapshot of the 
computer screen which was exhibiting the electronic MPR CT images with reference ruler 
present at ImageViewer interface, and pasted it to a new opened file which was created in 
Adobe Photoshop CS software and used the crop tool to crop the needed image region and 
saved it as in JPG format [2]. The JPG format image was then inserted to opened AutoCAD 
file as raster image to finish electronic quantitative measurement. By such steps, the 
morphology of SCP and quantitative anatomical data could be gotten successfully.  
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Fig. 4. Reconstructed sagittal CT images at CT machine-attached Advantage Workstation 

Based on these data, we fulfilled successful subaxial cervical transpedicular screw fixation 
manipulation. In this chapter, we introduce the details of using AutoCAD2010 software[3] 
to perform quantitative electronic measurement on subaxial cervical MPR CT images which 
were reconstructed with ImageViewer interface of Silver PACS software at the basis of 
sequential raw transaxial CT images. 
As the raster images opened in AutoCAD program were not real digitized images but JPG 
format ones. The precision is still limited, to some extent. Also, the procedures were tedious. 
In the near future, we hope new version of ImageViewer software can be developed to fulfil 
electronic quantitative measurement on MPR CT images. 

3. Content 

3.1 Getting raw transaxial CT images 
Volumetric CT ((GE, LightSpeed 16) scanning was performed on cervical spine samples 
with the samples on prone position one by one. We made sure the samples’ longitudinal 
axes were parallel to the CT machine’s longitudinal axis. The scan length was kept constant 
as 5-mm thickness. The entire subaxial cervical region was enrolled within the scanning 
region (Fig. 5).  
 

 

Fig. 5. Cervical spine sample 

Sequential raw transaxial CT image data of each sample were then generated by 
interpolation reconstruction method for a 0.625-mm thickness at 0.625 mm reconstruction 
intervals and saved as digital imaging and communication in medicine (Dicom) format 
documents using the CT machine-attached Advantage Workstation software. These image 

www.intechopen.com



AutoCAD for Quantitative Measurement  
of Cervical MPR CT Images Reconstructed in ImageViewer Interface   

 

109 

data could be stored in Disk array machine, so that they could be observed online  at a 
remote terminal computer or downloaded to hard disc of a terminal computer through 
Picture Archiving and Communication System (PACS)[6]. These data could also be directly 
burned to a compact disc or saved to a USB (Universal Serial Bus) flash disk. Here chose to 
burn the data to a compact disc.  

3.2 Reconstructing MPR CT images using the post-processing function of 
ImageViewer software 
Installed Imageviewer software to its default location on our personal computer. The 
software  could also be installed  to any other location.  
(1). Starting ImageViewer 
ImageViewer is a very good Windows program, we could make the program window 
appear on-screen in numerous ways. 
1. On the Windows taskbar, click Start, point to All Programs, point to ImageViewer button, 

then click;  
2. Open the ImageViewer folder, double-click the ImageViewer program icon 
3. During installing process, we chose to create an ImageViewer shortcut icon on our 

computer desktop. So, double-clicking the shortcut icon also could start the program.  
The running ImageViewer program window was shown as Fig.6 
 

 

Fig. 6. The ImageViewer Interface Window 

The title bar locates at the top of the screen, a menu bar just below it, a standard toolbar is 
below the menu bar, and a floating integrated toolbox pane on the right, which are very like 
those found in Microsoft Office System program window. If you have installed this softare, 
what you see on your screen might not match the graphics in Fig.5 exactly. That depends 
whether toolbars are chosen hide or show. The settings could be toggled by clicking their 
relative buttons on View menu’s subcommands.  
(2). Opening raw sequential CT images 

1. On the Standard toolbar of the ImageViewer , click the Open button. Or press Ctrl +O  to 

open the Open dialog box. 
2. In the Open dialog box, navigate to the folder that contains the  sequential raw CT images.  

3. Chose the sequential images that we want to open, then press Alt+O , or click the Open 

button, the chosen images will display (Fig.7). The image numbers displayed in the 
work area may vary. This depends on what display pattern we chose. Click relative 
display settings buttons on the standard toolbar, then the display pattern would change to 
fulfil our request (Fig. 8). 
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Fig. 7. To navigate to the folder which contains the raw CT images 

 

 

Fig. 8. Raw transaxial CT images opened at ImageViewer interface in sequence (four images 
in one work area). 

Only a few of the images can be displayed on the screen. We could choose to display other 
images by clicking their relative thumbnails on the left, or by dragging the Scroll bar just 
right to the work area. 
4. Deleting  unnecessary images. 
Following observation and identification, delete those raw images which are not belonged 
to the subaxial cervical spinal region from the folder (Fig.9~10). 
 
 

 

Fig. 9. Proximal transaxial images should be deleted(C1~2 spinal region, nine images in one 
work area) 
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Fig. 10. Distal images should be deleted (upper thoracic spinal region) 

5. Reconstructing MPR CT images  
Click delete button on the standard toolbar to delete all the displayed images at the work area 
(the original images still exist in the folder). Then open all the images which should be 
included in the reconstruction region from the folder again, then clicked the coronal/sagittal 
reconstruction  menu and scroll down to choose begin reconstructing icon and click (Fig.11). 
The MPR CT images with reference ruler then appear (Fig. 12). At this step, the raw axial 
images are  used for guiding as a reference. 
 

 

Fig. 11. To click begin reconstructing icon 

 

 

Fig. 12. Reconstructed MPR CT images at ImageViewer interface. A: Raw transverse CT 
image (act as localizer); B: Reconstructed coronal CT image ;C: Reconstructed sagittal CT 
image. 1.Localizer indicates coronal reconstructing plane; 2.Localizer indicates sagittal 
reconstructing plane;3.Reference ruler at coronal reconstructed CT image interface 
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The raw CT images chosen for reconstruction must be in sequence, neither repeated, nor 
interrupted images are permitted. Or the reconstruction couldn’t  be fulfilled. 
6. Adjusting required MPR images 
Mov the mouse cursor  to the raw axial CT image(Fig. 13A), and choose the coronal 
reconstructing plane localizer (Fig.12,arrow1) then drag the coronal localizer to proper position 
and inclination. During this process, the reconstructed coronal CT image will change 
simultaneously. The same can be done to sagittal reconstructing plane localizer (Fig. 13, 
arrow3). By such process, the real coronal MPR image which was perpendicular to the 
longitudinal axis of the pedicle and sagittal MPR image which just bisects the pedicle along its 
longitudinal axis are reconstructed. The lateral cortex is confirmed to be the thinnest (Fig.13-B). 
 

 

Fig. 13. To drag the localizers to suitable position and angulation to recontruct satisfied MPR 
images. A: Raw transverse CT image (acted as localizer); B: Reconstructed requierd coronal 
CT image; C: Reconstructed required sagittal CT image. 1.Localizer indicates coronal 
reconstructing plane;2.Localizer indicates sagittal reconstructing plane.3.Recontructed 
coronal image of subaxial cervical pedicle; 4.Reconstructed sagittal image of subaxial 
cervical pedicle 

7. Adjusting the size of MPR images  
Select the zoom tool from the floating integrated toolbox pane on the far right side of the work 
area, or click the ”image” menu and scroll down to choose ”zoom” subcommand icon and 
  

 

Fig. 14. To Select the zoom tool to magnify the raw CT image, the reconstructed MPR images 
maginfied  simultaneously with the reference rulers changing too.A:Magnified raw 
transaxial CT image;B:Reconstructed coronal CT image(magnified);C: Reconstructed sagittal 
CT imgage(magnified).  1.Localizer indicated coronal reconstructing plane;2.Localizer 
indicated sagittal reconstructing plane;3.Recontructed coronal image of subaxial cervical 
pedicle; 4.Reconstructed sagittal image of subaxial cervical pedicle;5.Changed reference 
ruler at coronal MPR image interface;6.Changed reference ruler at sagittal MPR image. 
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click.  Then move the cursor over the raw transaxial CT image area (Fig.14-A), the cursor 
would look like a tiny magnifying glass with a plus sign (+) in the center. Presse the left key 
of the mouse and drag the cursor downwards or rightwards, the raw image can be enlarged. 
Meanwhile, the reconstructed coronal and sagittal MPR images will enlarge with the 
reference rulers changing simultaneously. If we drag the cursor upwards or leftwards, the 
raw and reconstructed images would diminish simultaneouly. 
8. To reconstruct MPR images from only one vertebral raw transaxial CT images 
We could also choose part of sequential raw transaxial CT images which mainly come from 
only real vertebra, thus the reconstructed MPR images only displayed the proper CT images 
of one vertebral structure (Fig.15). 
 

 

Fig. 15. Reformatted MPR CT imges from sequential raw transaxial CT images of only one 
cervical vertebra 

(3). Simple and rough linear and angular measurement of raw transaxial CT image. 
Chose line icon at the measure toolbar (Tip: we could click View button on the standard menu 
and then click the measure toolbar subcommand button to show the toolbar if it was hidden). 
We could finish rough linear measurement at raw transaxial CT image. If we chose angular 
icon, the angular measurement could be finished on raw CT images. But linear or angular 
measurement could not be fulfilled at reconstructed MPR image (Fig 15). The linear 
measurement precision is limited as 0mm.  Angular measurement precision is 0.00. 
Compared to the measurement precision that AutoCAD could provide, the values are 
rougher. 

3.3 Creating .JPG documents of MPR CT images with Adobe Photoshop CS 
(1). Capturing a snapshot of the computer screen 
First press Windows Print Screen Key to capture a snapshot of the computer screen which 
exhibits the ImageViewer interface with the raw CT and reformatted CT images and copy 
the snapshot to the clipboard 
(2). Creating a new image document with Adobe Photoshop CS. 
Firstly, start Adobe Photoshop CS program to open the Photoshop interface, then press 

Ctrl+N to create a new image document.  After this, the New Dialog Box appears. On the 

New dialog box, choose resolution as 300 pixels/inch, color mode as RGB color, background 
contents as  white, then click OK(Fig. 16). The new document work area appears. 

Following , press Ctrl+V, the  snapshot will be pasted to the new created document as a 

new layer (Fig. 17). 
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Fig. 16. To create a new document with Adobe Photoshop 

 

 

Fig. 17. To paste the snapshot in the new created document opened in Adobe Photoshop 

(3). Editing image  
Choose rectangular marquee tool at the toolbox (locate at the left side of the work area). Then 
move the cursor over the image window, drag the cursor to draw a rectangule around the 
required image area and then release the mouse button. An animated dashed line indicates 
that the area inside it is selected. 
Click the Image menu and drag down to select the crop icon, and then click. Only the selected 
image is left (Fig. 18).  
 

 

Fig. 18. Only selected area is left after clicking Crop icon 

Following , click the layer menu and drag down to select the merge layer icon to merge the 
two layers together.  
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(4). Saving the merged image document as .JPG image 
Click the File menu and drag down to select save as icon, the Save As dialog box appears, 
saved the image as .JPG document to destined folder for further use[3] (Fig.19). 
 

 

Fig. 19. To save the selected area as .JPG document 

3.4 Finishing electronic quantitative measurement of MPR CT images using AutoCAD 
2010 
(1). Starting AutoCAD 2010 
We can select one of the following to start AutoCAD: 
1. Double-click  the AutoCAD shortcut icon on the desktop. 
2. Click the Start button→(All) Programs→Autodesk→AutoCAD 2010→ AutoCAD2010 

icon, then clicked.  
After this step, the New Features Workshop box appears, select the Maybe Later option on the 
left and click OK (Fig.20). The AutoCAD program window will appear. 
 

 

Fig. 20. To select Maybe later option when encounter the New Features Workshop 

(2). (2)Inserting  MPR CT image as raster image 
We did the followings: 
1. On the ribbon, click the Insert tab. 
2. On the Reference panel, click the attach button (Fig. 21), the Select Reference File box will 

appear (Fig .22). 
On the “Select Reference File” box, navigate to the folder that contains the MPR CT images. 
Then browse to the raster image file (.JPG format) that we want to attach (the image we 
want to fulfil quantitative measurement in AutoCAD) and select it, then click Open (Fig.22). 
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Fig. 21. To access attach command on the reference panel 

 

 

Fig. 22. To choose the image that we wanted to measure 

The Select Image File dialog box closes, and the Attach Image dialog box appears. Click Details 
button to display additional information about the selected image (Fig. 23). 
 

 

Fig. 23. To attach a raster image reference 

The path to and the name of the file we selected appear  in the Found In and Saved Path 
fields, respectively. The Name drop-down list allows us to select a previously attached raster 
image file, and Browse allows us to specify a different raster image file to reference. The 
Image Information area provides feedback on how the image would be scaled when it is 
inserted. We could also click Hide Details button to hide the additional information. 
In the Path Type area, we specify the path format as full path. In the Insertion Point area, 
choose <0,0,0>,in the Scale area, choose <1>, in the Rotation area, choose <0>, then press OK 
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button (we could also choose other choices). The selected MPR image appears at AutoCAD 
work area. 
(3). Adjusting the image to proper location and proper magnified extent.   
Move the cursor to work area, then right-clicked the mouse to display shortcut menu and 
chose zoom button (Fig.24). 
 

 

Fig. 24. To choose zoom shortcut 

We then right-clicked the mouse again to display zoom menu shortcut and chose zoom 
extends button, the inserted image fitted the whole window (Fig.25). 
 

 

Fig. 25. To choose zoom extents to make the image occupy the whole active window area. 

Then we moved the portion that we wanted to measure to the center of the window screen 
and adjusted it to suitable size by using pan and zoom icons’ functions alternatively (Fig.26). 
 

 

Fig. 26. To move the measured portion to the center of the active window screen by pan and 
zoom buttons alternatively.   
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(4). Adjusting reference factor for accurate measurement 
1. On the ribbon, click the Home tab. 
2. On the Draw panel,  click the point button. 
3. Then draw point objects at the start point and end point of the reference ruler of the 

MPR image, respectively. Later, they are chosen as specified node points for the origins 
of dimensions (Fig .27).  

 

 

Fig. 27. To draw point objects for the origins of dimensions  

4. Toggling the Object Snaps on for correct measurement. 
Object snaps let one pick a precise point. We use object snaps to make sure that the 
dimensions are created with the correct measurement.  Node objects are chosen as specified 
points. Clicking the Object Snap button toggles the Object Snap on if it is off, then right-click 
the Object Snap (OSNAP) button on the Status Bar and toggle the Node object snaps on  from 
the shortcut menu (Fig.28).  
 

 

Fig. 28. To turn the Node object snap on from the shortcut menu. 

5. Creating a new dimension style 
Type  dimstyle on the command line to display the Dimension Style Manager dialog box, then 
click  New button. The Create New Dimension Style dialog box is displayed. 
In the New Style Name text box, enter reference as the new name for the dimension style.  In 
the Start With drop-down list, select standard.  After this, click continue button. The New 
Dimension Style dialog box then is displayed. Click  OK button to return to the Dimension 
Style Manager dialog box. Then click Set Current button to set the reference dimension style to 
current. Following click Close button to close the dialog box. The reference dimension style is 
applied to dimensions  we  created. 
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6. Creating a linear dimension 
On the ribbon, click the Annotate tab. Then on the Dimensions panel, click the dimension 
flyout button and chosoe linear icon (Fig.29). 
 

 

Fig. 29. To choose liner dimension 

At the prompt, pick the node which had been drawn at the start location of the reference 
ruler for the first origin point of the dimension. After this, the prompt Specify second extension 
line origin is displayed. Then move the cursor to the second node which has been drawn at 
the end point of the reference ruler for the second origin point of the dimension and click. 
As the prompt Specify dimension line location is displayed, pick a point to place the 
dimension, the linear dimension will display.  But the value is not identical to real reference 
ruler length (Fig.30).  
 

 

Fig. 30. Original vertical linear dimension is displayed 

7. Displaying correct reference value by modifying the dimension style in use. 
Type dimstyle on the command line to display the Dimension style Manager dialog box again. 
In the Styles list box,  select reference, then click Modify button to display the Modify 
Dimension Style dialog box.  In the Modify Dimension Style dialog box,  click Symbols and 
Arrows tab, change the arrow size to desired size; click Text tab, chang the text height to 
desired height; click Primary Units tab, specified Precision as 0.0, suffix as mm, specify 
measurement Scale factor to a proper value, then click OK to save the changes to the reference 
dimension style and to close the Modify Dimension Style dialog box. Any dimensions using 
the modified style (reference) are automatically updated to reflect the changes. Here when 
we modify the measurement  Scale factor to 2.2240, the vertical linear dimension value is  
identical to  the real reference ruler length (30.0mm ). By changing other styles proper value, 
the dimensions created are shown clearly on the computer screen (Fig.31). 
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Fig. 31. To adjust Scale factor till the vertical linear dimension value changes identical to the 
reference ruler value the dimensions created can be observed clearly. 

(5). Correct electronic quantitative measurement of the MPR CT images 
To get correct linear distance values, operate as the followings: 
1. On the ribbon, click the Home tab. 
2. On the Draw panel, click the point button 
3. Draw point objects at the MPR CT image’s proper positions to identify the start point 

and end point for relative linear dimension display. 
4. On the Dimensions panel, choose the aligned linear dimension button 
5. Pick the start node and then the end node. Then relative aligned distance value displays 

(Fig.32). The value is just the one we want to get. Here the value’s precision is 0.0mm. 
We could choose to change precision setting on the Modify Dimension Style dialog box as 
we like; Toggling Object snaps on and turning on the Node object snaps guarantee 
correct and precise measurement if the positions of point objects are positioned correct. 
As the start and end nodes are fixed, the aligned linear dimension value is determined 
identical, no matter what time we do the measurement.  

 

 

Fig. 32. Electronic quantitative measurement of the MPR sagittal CT image. 

The reference ruler length at sagittal image is not identical to that at coronal image.  We ‘d 
first made correct reference value on coronal MPR CT image by modifying scale factor value 
at Primary Units tab in the Modify Dimension Style dialogue box, then repeat the same steps, 
the electronic quantitative measurement of the coronal CT image could be achieved  
successfully  (Fig. 33). 
Chose Angular Dimension, then the superior and medial angles of the pedicle can be 
displayed (Fig.34). 

www.intechopen.com



AutoCAD for Quantitative Measurement  
of Cervical MPR CT Images Reconstructed in ImageViewer Interface   

 

121 

 

Fig. 33. To finish electronic quantitative measurement of the MPR coronal CT image 

 

 

Fig. 34. To finish electronic quantitative angular measurement of the MPR sagittal CT image 

We could also make correct electronic quantitative measurement of the raw Transaxial CT 
images if we are not satisfied with  the values measured in ImageViewer software.  
Repeat the above-mentioned steps, each pedicle’s linear and angular quantitative data could 
be gotten precisely as desired. 
The following table is some linear value data we got in eight subaxial cervical samples. 
 

 MCP LCP SCP ICP ACL ACS ACI PCT 

C3 
1.9±0.3 
(1.3~2.1) 

0.8±0.4 
(0.3~1.2) 

2.1±0.5 
(1.5~2.7) 

2.3±0.6 
(1.9~3.2) 

2.3±0.5 
(1.6~2.9) 

1.9±0.4 
(1.6~2.7) 

1.9±0.3 
(1.5~2.2) 

0.9±0.2 
(0.8~1.2) 

C4 
2.3±0.7 
(1.8~3.5) 

1.4±0.4 
(0.9~2.0) 

2.4±0.5 
(1.8~2.8) 

2.2±0.4 
(1.9~2.8) 

2.2±0.3 
(1.9~2.7) 

2.1±0.3 
(1.7~2.4) 

2.5±0.6 
(1.8~3.2) 

0.9±0.4 
(0.5~1.4) 

C5 
2.3±0.2 
(2~2.6) 

1.5±0.3 
(1.1~1.8) 

2.5±0.8 
(1.8~3.6) 

2.3±0.6 
(1.9~3.3) 

2.0±0.3 
(1.7~2.5) 

1.8±0.7 
(1.3~3.3) 

2.8±0.6 
(1.8~3.8) 

1.2±0.4 
(0.8~1.8) 

C6 
1.9±0.2 
(1.5~2.2) 

1.2±0.2 
(0.8~1.3) 

2.4±0.6 
(2.0~3.6) 

2.3±0.5 
(1.9~3.1) 

1.7±0.2 
(1.3~1.9) 

1.8±0.3 
(1.3~2.0) 

2.8±0.4 
(2.4~3.5) 

1.0±0.3 
(0.8~1.4) 

C7 
2.0±0.5 
(1.5~2.8) 

0.9±0.3 
(0.5~1.3) 

2.0±0.3  
(1.6~2.5) 

2.2±0.4 
(1.6~2.7) 

1.8±0.2 
(1.6~2.2) 

1.8±0.3 
(1.5~2.2) 

2.1±0.4 
(1.6~2.5) 

0.9±0.3 
(0.6~1.3) 

* MCP: medial cortex of pedicle. LCP:lateral cortex of pedicle SCP:superior cortex of pedicle. ICP: 
inferior cortex of pedicle ACL:anterior cortex of lamina ACS:anterior cortex of superior articularis 
ACI:anterior cortex of inferior articularis PCT posterior cortex of transverse foramen  

Table 1. Cortex thickness measurement of subaxial pedicle and its adjacent structures 
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The results confirmed that the lateral cortex of the subaxial cervical pedicles was 
significantly thinner than medial, superior, and inferior counterparts. 
Based on above-mentioned and other relative linear and angular values, we tried some new 
techniques to perform subaxial cervical transpedicular manipulation by hand. All suitable 
pedicles were performed successfully (Fig .35). 
 

 

Fig. 35. Successful subaxial transpedicular manipulation  

Although it seems tedious and troublesome from the above-mentioned steps description, but if 
one is familiar with AutoCAD, it is very easy to finish the steps mentioned-above.  What we 
need to do is just translating the MPR image into JPG-format image and inserted it into 
AutoCAD interface as raster image. Other measurement steps are very simple and easy to do.  

4. Conclusion 

To make successful transpedicular screw fixation in subaxial cervical spinal region, the 
anatomical characteristics of subaxial cervical spine must be thoroughly understood. Many 
previous morphologic studies based on cadaveric specimens and CT images have mainly 
focused on transverse diameter of the pedicles [15]. Realizing the complex morphologic 
features of the subaxial cervical pedicles in spatial orientation and vital neurovascular 
structures adjacent, these studies are far from enough. To get successful subaxial cervical 
transpedicular screw insertion, surgeons must make in mind the anatomical features in 
three dimensions clearly. Volumetric CT scanning could reconstruct multiplanar CT images 
needed at CT-machine attached Advantage Workstation. But it is not realistic to reconstruct 
wanted subaxial cervical MPR CT images and to finish quantitative measurement using the 
measurement tools of the Workstation at every time, while a spinal surgeon who is 
interested in subaxial cervical transpedicular screw insertion study may not allowed to 
manipulate the Advantage Workstation. Even the surgeon is allowed to manipulate at rare 
condition, he may not familiar with the sophisticated operating procedures. ImageViewer 
software is a very good and easy-to-learn Windows program and has been authorized to our 
hospital. Every terminal computer has been installed this program. The software could 
reconstruct qualified MPR CT images with reference ruler present based on sequential raw 

CT images to fulfil primary and qualitative observation. AutoCAD program is developed 
primary to create accurate 2D and 3D designs, to do much more complex things that 
were not possible with board drafting, and the new-emerged versions are able to be 
installed on personal computers, have become into something that we could take on-
site with us. AutoCAD program has been introduced into medical field to realize 
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precise quantitative measurement in recent years [7]. But using AutoCAD to realize 
quantitative measurement of MPR CT images are rarely reported. By selecting proper 
MRP CT images reconstructed using ImageViewer program  and saving them as .JPG 
images using Adobe Photoshop program, we got raster images for further quantitative 
measurement with AutoCAD program. When these images were inserted into opened 
AutoCAD document, and proper nodes were drawn at special locations of the images, 
we could get precise linear and angular values, which guaranteed our entrance point 
and direction determination of transpedicular screw fixation.  With these quantitative 
data in mind, we successfully finished subaxial cervical pedicle screw fixation 
manipulation on suitable pedicles.  
There are two kinds of images: bitmap and vectorgram images [13] .Vectorgram images are 
essentially presentation of computer programming language based on mathematical 
expressions, no matter simple or sophisticated, their qualities are not influenced by 
magnifying or decreasing the image. While the qualities of bitmap images are determined 
by image size dimensions and resolution.  The images in JPG format are belonged to bitmap 
kind. Realizing JPEG compressed images would produce some artifacts, the visualization of 
details of MPR CT images inserted in AutoCAD program for quantitative measurement is 
determined by raw .JPG image size. So determining the specified points for measurement is 
mainly estimated by the observers, what we introduced here is just the very likelihood 
estimation of special points’ determination. Thus the measurement data got were non-rigid. 
But we think they are satisfied enough to guide the pedicle screw insertion. 
It seems tedious and troublesome from the description above, but if one is familiar with 
AutoCAD, it is very easy to finish the steps mentioned-above. In fact, what we need to do is 
just translating the MPR image into JPG-format image and inserted it into AutoCAD 
interface as raster image. Other measurement steps are very simple and easy to do. 
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